CAUTION: Read this manual before using the device. Check www.zargis.com for updated versions of the StethAssist User Manual
# TABLE OF CONTENTS

1. General Information .......................................................................................................................... 3
2. Getting Started ................................................................................................................................. 4
3. Upgrading Your Software .................................................................................................................. 8
4. Web-enabled Collaboration via the Zargis Telemedicine Server .................................................. 8
5. Instructions for Use ........................................................................................................................... 9
6. Reviewing Recordings ...................................................................................................................... 12
7. Saving Files and Opening Previously Recorded Data .................................................................... 13
8. Exporting & Importing Data ......................................................................................................... 14
9. Navigating Menus ............................................................................................................................ 14
10. Understanding Recording Quality ............................................................................................... 15
11. Troubleshooting ............................................................................................................................ 16
12. Warranty Information .................................................................................................................... 17
1. General Information

1.1. Indications for Use

StethAssist is an electronic device intended to be used with an electronic stethoscope for the recording and display of heart sounds and other physiological acoustic signals.

1.2. Precautions

This manual provides instructions for use of the StethAssist device and assumes that the user is familiar with the Windows operating system on PCs. Zargis recommends that all personnel who operate the device thoroughly read and understand this manual.

The device is intended for use in a physician office setting. As with normal auscultation, it is recommended that the physician’s office have minimal background noise from the street, telephones, radio, conversation, and office clatter.

It is strongly recommended that the users of the StethAssist software use computing and networking security features to protect patient data created and stored using this software. Please consult your institution’s data management or computer technical service personnel to implement appropriate security measures. The user assumes all risks, responsibilities and liabilities when user identification and password protection features are bypassed, disabled or ignored.

A WARNING, CAUTION, and NOTE used in this manual will be boxed and have the following significance:

WARNING: Maintenance or operating procedures, techniques, etc., that may result in possible injury, death, or other serious adverse reactions if not carefully followed.

CAUTION: Maintenance or operating procedures techniques, etc., that may result in equipment malfunctions, equipment failure or damage to equipment if not carefully followed.

NOTE: Maintenance or operating procedure that is considered essential to emphasize.

1.3. System Requirements

To run version 1.0 of the StethAssist software, your system must meet these specifications:

- Windows XP SP2 or later or Vista 32-bit.
- 512MB of RAM.
- Intel Pentium 4 compatible or later.
- 1024 x 600 graphic display or better.
- USB 1.1 port or better.

The specifications of the USB wireless dongle are as follows:

- Compliant with Bluetooth V1.1, V1.2 & V2.0.
- Supporting profiles: Networking, Dial-up, Fax, LAN access, and Headset.
- Operating system: Windows XP and Vista.
- Interface: Compliant with USB 1.1 & 2.0.
- Data transmission rate: 3Mbps.
- Working distance: 5-10m.
- FCC approval: FCC ID - WQ7 I-BTD-04.

NOTE: The USB Transceiver device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: 1. This device may not cause harmful interference, and 2. This device must accept any interference received, including interference that may cause undesired operation.

FCC NOTE: THE MANUFACTURER IS NOT RESPONSIBLE FOR ANY RADIO OR TV INTERFERENCE CAUSED BY UNAUTHORIZED MODIFICATIONS TO THIS EQUIPMENT. SUCH MODIFICATIONS COULD VOID THE USER’S AUTHORITY TO OPERATE THE EQUIPMENT.

1.4. Patient Privacy

The privacy and security of certain individually identifiable health information may be protected by state, federal, international, and/or foreign laws that regulate and restrict how such information can be used, disclosed, stored and transmitted. In some instances, you may even be prohibited from permitting any third party to access such information without first obtaining prior written authorization to do so.

You are solely and fully responsible for determining, understanding, and complying with any and all laws that affect how you may store and transmit any electronic individually identifiable health information through use of the Software. If you determine that you are not able to comply with a law or restriction that applies to your use and disclosure (including transmission) of individually identifiable health information through the Software, then you should not proceed to save such information. By proceeding to save any information, you hereby assume all risks, responsibilities and liabilities associated with using, storing, and/or transmitting such information, including sound files, electronically or otherwise.

This program does not require you to enter individually identifiable health information in order to function. Records can be stored and recalled through the use of a timestamp or an arbitrarily assigned identifier. If you choose to enter a meaningful Patient Name or Patient Identifier, then you agree to assume any and all risks of and liabilities incurred with transmitting and storing such individually identifiable health information through the Software, including risks to the privacy and security of such individually identifiable health information.

2. Getting Started

2.1. Installing the StethAssist Software

Follow these steps to install StethAssist on your computer:

1. Insert the CD into the CD-ROM drive on your computer.
2. The installation program will start automatically. If the program does not start, open the CD folder and double click the file labeled setup.exe.

2.2. Installing the USB Wireless Dongle

The USB wireless dongle allows communication between the PC on which the StethAssist software is installed and electronic stethoscopes that Zargis Medical Corp. has approved for use with StethAssist. The USB wireless dongle receives and transmits data via the commonly accepted Bluetooth® short range wireless connectivity standard.

To install the USB wireless dongle, plug the device into an open USB port on the PC on which the StethAssist software has been loaded and activated.

Anytime StethAssist tries to connect to the stethoscope but does not detect a USB wireless dongle on the PC, the following screen will be displayed:

Wireless Dongle Detection Window

2.3. Registering Your Software

To register your copy of StethAssist, click the “Register” option under the Help file menu and follow the instructions that appear.

2.4. Pairing & Connecting the Stethoscope with the StethAssist Software

After launching the StethAssist software, the following screens will help you connect StethAssist to your stethoscope.
Launch Window

Do you wish to wirelessly connect to your Model 3200 stethoscope now?

Yes, connect now. (First make sure the blue USB wireless dongle is inserted)

No, do not connect. (I want to review recordings without connecting to the stethoscope)

Add New Stethoscope Window

To connect to a Model 3200 stethoscope for the first time, you must follow the steps below to "pair" the stethoscope with StethAssist.

**Step 1:**
Press (M) on the stethoscope.
Use (+) and (-) to select "PAIR".
Then press the (M) button again. A 4-digit PIN number will appear on the stethoscope LCD screen.

**Step 2:**
Enter the PIN number here: PIN

**Step 3:**
Create an ID for the stethoscope and enter it here: Stethoscope ID

**Step 4:**
Click the "Pair Now" button below.
The screen below will appear each time you attempt to connect StethAssist to your stethoscope.

**Stethoscope Connection Window**

Press (M) on the stethoscope to select "CONNECT", and then press the (M) button again.

Tips for Preventing Lost Wireless Connections

1. Auscultate the patient as close to the PC as possible.
2. Avoid having objects or people between the stethoscope and the PC.
3. Avoid having your hand cover the entire chest piece (location of the stethoscope’s Bluetooth antenna.)

---

2.5. **Adding Comments to a Recording**

While in the “Detailed View”, you can add comments to a file by clicking on the “Comments” icon located to the left of the Patient ID. A green check mark on this icon indicates that comments exist for the file.

2.6. **Adding a New Stethoscope**

To connect any Model 3200 stethoscope to any installation of StethAssist for the first time, you must launch the “Add New Stethoscope” window. This window is accessible by selecting “Add New Stethoscope” from the “Tools” menu or by selecting “Add New Stethoscope” from the pull-down field to the right of the “Stethoscope Connection” button.

2.7. **Connecting Your Stethoscope**

Once you’ve added a stethoscope as described above, the stethoscope can be connected to StethAssist. This connection can take place upon StethAssist launch or by selecting your stethoscope from the pull-down field to the right of the “Stethoscope Connection” button. If
your stethoscope is not connected, the Stethoscope Connection button will display a red “X” instead of a green “✓”.

NOTE: Follow these tips to prevent lost wireless connections
1. Auscultate the patient as close to the PC as possible.
2. Avoid having objects or people between the stethoscope and the PC.
3. Avoid having your hand cover the entire chest piece (location of the stethoscope’s Bluetooth® antenna.)

You can add multiple stethoscopes to each copy of StethAssist, but only one stethoscope can be actively connected at a time.

NOTE: It is not possible to connect to a stethoscope that is actively connected to another PC.

3. Upgrading Your Software

3.1. Upgrading to Cardioscan

Go to www.zargis.com or contact Zargis at sales@zargis.com to upgrade your StethAssist to Cardioscan, the computer-aided auscultation device designed to support physicians in analyzing cardiac sounds for the identification and classification of suspected murmurs. Designed by biomedical scientists at Siemens and Zargis, Cardioscan identifies suspected systolic and diastolic murmurs, and indicates whether or not a suspected murmur meets the characteristics for classification as a Class I murmur according to guidelines jointly established by the American College of Cardiology and the American Heart Association. The Cardioscan software is also compatible with your 3M Littmann Model 3200 stethoscope.

4. Web-enabled Collaboration via the Zargis Telemedicine Server

Go to www.zargis.com or contact Zargis at sales@zargis.com to acquire access to www.ZargisTelemed.com—Zargis’ telemedicine portal—which allows you to share files with other physicians and/or cardiologists for immediate second opinions.
5. Instructions for Use

5.1. Icons & Buttons

The following is an example of the StethAssist detailed view window.

- Drag: Enables use of mouse cursor to drag sound display left or right
- Start recording
- Stop
- Pan left
- Pan right
- Connect to telemedicine server
- Zoom in
- Zoom out
- Global Scaling: Enables global scaling for all sound displays.
- Re-record
- Press (M) button on stethoscope to record
- Filter selection
- Open file
- Save file
- Comments
- Delete site recording
- Phonocardiogram (PCG) view of sound display
- Spectrogram view of sound display
- Stethoscope Connection Indicator
- Start recording
- Zoom in
- Zoom out
- Global Scaling: Enables global scaling for all sound displays.
The following is an example of the StethAssist Summary view.

5.2. Methods for Proper Auscultation

Please follow these instructions to properly run an auscultation protocol with the device:

1. Ensure that the environment is as quiet as possible.

2. Prepare the patient as if the protocol were for any normal auscultation exam. Before starting the protocol, position the patient in the desired posture. Ask the patient to remain quiet and still for the duration of the recording.

3. Adjust the stethoscope so that the earpiece volume level is at a setting you find comfortable.

   NOTE: The volume level of the stethoscope does not affect the volume level of recordings.

4. Ensure that the ID for the stethoscope you intend to use for the exam is listed in the Target Stethoscope box at the top of the window. To connect with a different stethoscope (one which has already been paired), use the pull-down arrow on the right side of the Target Stethoscope box. For instructions on pairing a stethoscope

StethAssist version 1.0 - User Manual. 001-LB-0001EN Rev 1

Page 10 of 17
with the software, see the section of this manual entitled: “Pairing & Connecting the Stethoscope with the StethAssist Software”.

5. Click on the Start button to launch the Recording Set-up Window.

6. In the Recording Set-up Window, enter a patient ID in the Patient ID field. Use an ID letter and/or number combination that allows ready access to all patients under your care. (Patient ID names may contain any combination of letters and numbers up to 20 characters long. Note that StethAssist ONLY permits use of the following characters in patient IDs: any letter, any number, the dash symbol, and the underscore symbol).

**Recording Set-Up Window:**

7. Once you’ve selected your recording site and confirmed that your stethoscope is wirelessly connected, press the (M) button on the stethoscope to begin recording. If your stethoscope is not connected, the “Stethoscope Connection” button will display a red “X” instead of a green “✓”. To reconnect, simply click on the “Stethoscope Connection” button.

8. To restart the recording, press the (M) button on the stethoscope once to reset the recording, and then press the (M) button another time to begin recording again.

9. After the recording has been completed, you may conduct another recording on the same patient by clicking the “Start” button. To make a recording on a different patient, select the “New Encounter” radio button and then click the “Start” button.

10. Listen to the patient’s sounds at the indicated site. Once a recording begins, you will see the waveform for the site, in real-time, in the sound display corresponding to the recording site.
11. It is preferable to auscultate on top of bare skin. To reduce hand-motion artifacts, hold the stethoscope with a steady hand while recording.

For additional information about conducting quality recordings, see the section entitled “Understanding Recording Quality”.

6. Reviewing Recordings

After successful completion of a recording, you may review the recorded data. The Switch View icon located at the top right of the “Detailed View” window allows you to switch over to the “Summary View” window.

6.1. Signal Pan & Zoom

To zoom in or out on a sound display, first “select” the chosen display by clicking on it, then make use of either the Horizontal Zoom or Vertical Zoom buttons. Zooming in provides more detail. Zooming out provides less detail. The Vertical Zoom will also increase and decrease the volume of the recording as it affects the visual and the audible amplitude of the recording.

You can scroll along the analyzed heart sound signal by using the Pan buttons. To move left, select the chosen display by clicking on it and then make use of the Pan Left button. To move right, select the chosen display by clicking on it and then make use of the Pan Right button.

Note: It is also possible to pan left and right through the sound displays by using the Drag icon located on the toolbar. Click this hand-shaped icon and you have the ability to pan left or right through any of the sound displays in the results windows by placing the mouse cursor on a sound display and then dragging the cursor in the direction you wish to scroll. Deactivate this feature by clicking the Drag icon again.

6.2. Spectrogram Display Option

The spectrogram is a time-frequency distribution presented as a two-dimensional color plot of the heart sound energy distributed over time and frequency. Black represents minimum energy while red is maximum energy. The x-axis represents the time index while the y-axis is a linear frequency range of 0 – 500 Hz. The spectrogram provides an additional perspective on the recorded sound. To view a sound display in spectrogram mode, click the Spectrogram icon appearing to the left of the sound display. To return a sound display to the standard, default view, click the PCG icon that appears to the left of the display.

6.3. Playing Back a Recording

Press the Play button to begin playback. StethAssist plays what you see in the graph. Note that during playback a red cursor scrolls across the sound display in synchrony with the recording. Click the Stop button to end the playback.
6.4. Slow Playback

The Slow Playback button allows you to play back recordings at half speed with no significant change in the spectral properties of the signal. Click the Slow Playback button, and then click the Play button to play back the recording at half speed. Once clicked, the Slow Playback button stays activated until it is clicked again.

6.5. Playing Back a Specific Portion of a Recording

To play back a specific portion of a recording, simply click with your mouse on the area of the sound display where you want playback to begin and drag your mouse to the right to highlight the area of interest. Once an area of the sound display has been highlighted in this way, hit the Play button to listen to the specific section. Note that you must select a segment of sound of at least one second in duration in order for this feature to function. Clear a highlighted area by left-clicking anywhere on the sound display.

6.6. Loop Playback

The Looped Playback button appearing at the top of the screen allows you to play back an entire recording, or a specific portion of a recording, in a loop that will continue until the Stop button is clicked. To play a full recording in loop mode, select the corresponding sound display by clicking on it, then click the Loop Playback button, and then click the Play button. To play a specific portion of a recording in loop mode, use the cursor to highlight the area of interest on a sound display, then click the Loop Playback button, and then click the Play button. Once clicked, the Loop Playback button stays activated until it is clicked again.

6.7. Printing Feature

To print a copy of the “Patient Encounter Report” for a given recording or recording set, click the Print button. The resulting print-out will display the patient ID, patient name (if entered), and the ID of the stethoscope used for the recordings. The report will also contain a listing of the posture, auscultation site and time-length for the recording(s) in question, along with any corresponding user comments that were entered.

7. Saving Files and Opening Previously Recorded Data

Save a file by clicking the “Save” icon in the upper left corner of the screen.

Use the “Open File” icon, or select the “Open” option under File, to open a previously created recording set.
8. Exporting & Importing Data

8.1. Exporting Data

StethAssist allows you to export a recording in the common .WAV file format to a USB flash drive, the local hard drive of your computer, or to a server. To open the File Export window, select Export WAV under the File menu.

8.2. Importing Data

StethAssist permits you to import files from a server that are in the .E4K format. To open the File Import window, select Import E4K under the File menu.

8.3. Import Recordings from Stethoscope Memory

To transfer a recording to StethAssist from the Model 3200’s on-board memory, select “Import From Stethoscope” from the File menu.

9. Navigating Menus

StethAssist contains the following menu selections:

File   Tools   Help

9.1. File

File | New Encounter
Select this option to begin a new patient recording.

File | Open
Select this option to open a previous recording set.

File | Save
Select this option to save a previous recording set.

File | Comments
Select this option to open the comments window.

File | Import From Scope
Select this option to import a recording from the stethoscope’s on-board memory.

File | Import E4K
Select this option to import a file in the .E4K format.

File | Export WAV
Selecting this option opens the File Export window.

File | Print Report
Select this option to print the Patient Encounter Report for a given recording set.
9.2. Tools

Tools | Stethoscope Settings
Selecting this option opens the Stethoscope Settings window, where you can:

- Set the default setting for patient posture.
- Adjust the length of the “lead time”, or waiting period, before StethAssist begins recording at a site. Lead time options: 0, 1, 2 or 4 seconds.
- Select the default recording length.
- Select the default view (summary or detailed).

Tools | Add New Stethoscope
Selecting this option opens the “Add New Stethoscope” window.

9.3. Help

Help | StethAssist User Manual
Selecting this option opens the StethAssist User Manual.

Help | Contact Zargis Medical
Use this option to view contact information for Zargis and provide feedback about our products.

Help | About Zargis StethAssist
Select this option to view the product version number along with numbers and addresses for requesting further information or making service inquiries.

Help | Register StethAssist
This will bring up the “Registration” window.

Help | Learn About Zargis Cardioscan
Select this option to view information about Zargis’ Cardioscan product.

10. Understanding Recording Quality

The quality of the recordings depends on user technique, the environment, and subject compliance. High-quality recordings will increase the accuracy of the analysis results.

There are three main factors that affect recording quality:
The acoustic environment: Try to ensure that the auscultation procedure is carried out in a quiet environment. Listen carefully for background sounds, such as that caused by traffic noises entering through open windows or by fans and air conditioners, and eliminate these noises to the extent possible. Make sure that there are no background conversations being conducted during recording. Take steps to prevent interruptions during the protocol.

The patient: The patient should be properly prepared so that the recordings can be made with the stethoscope against bare skin. The patient should be instructed to breathe in a normal and quiet manner. The patient should be instructed to maintain a still and steady posture.

The placement and handling of the stethoscope: The stethoscope should be carefully and accurately positioned to obtain best signal quality. It is also important to hold the stethoscope in position in a manner that minimizes motion artifact. StethAssist automatically selects a gain level based upon the first two seconds of recording, so if the first two seconds of the recording are very soft, StethAssist could inappropriately increase the gain setting. Make sure that the first two seconds are representative of the entire recording.

11. Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Potential Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cannot connect to stethoscope</td>
<td>No USB wireless dongle installed/ USB wireless dongle not properly installed</td>
<td>Install USB wireless dongle. See the section of this manual entitled “Installing the USB wireless dongle”</td>
</tr>
<tr>
<td></td>
<td>Stethoscope not paired</td>
<td>Pair stethoscope. See the section of this manual entitled “Pairing &amp; Connecting the Stethoscope with the StethAssist Software”</td>
</tr>
<tr>
<td>Each unique Stethoscope ID can only be connected to one stethoscope</td>
<td>If your office has multiple stethoscopes, make sure you are trying to connect to the correct Stethoscope ID.</td>
<td></td>
</tr>
<tr>
<td>Undetermined</td>
<td>Turn off the stethoscope, wait a few seconds, and then turn the stethoscope back on.</td>
<td></td>
</tr>
<tr>
<td>Noisy recorded signal</td>
<td>Excessive background noise</td>
<td>Take actions to reduce the background noises heard in the auscultation environment</td>
</tr>
<tr>
<td>Signal shown in the display plots is clipped</td>
<td>Noisy recording</td>
<td>See the section of this manual entitled “Understanding Recording Quality”</td>
</tr>
<tr>
<td>Poor data quality reported</td>
<td>Excessive background noise</td>
<td>Take actions to reduce the background noises heard in the auscultation environment</td>
</tr>
<tr>
<td>Excessive stethoscope motion</td>
<td>Hold the stethoscope with a steady hand, firmly pressing against the patient’s skin while recording</td>
<td></td>
</tr>
</tbody>
</table>
If you experience a problem with the StethAssist device that is not addressed in this manual, please review our support and Frequently Asked Questions page at www.zargis.com/support. If you are still unable to solve the problem, please email a detailed description of the problem to ZSAsupport@zargis.com.

12. **Warranty Information**

Please refer to your StethAssist End-User License Agreement for the terms of your warranty.

3M is a trademark of 3M. Littmann is a registered trademark of 3M. Windows is a registered trademark of Microsoft. Bluetooth is a registered trademark of the Bluetooth SIG, Inc.